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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.  

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

Summary of Changes This publication contains new and updated information as indicated in the 
following table.

Safety Information

Topic Page

Revised connection information, removed network cable connection option. Throughout

Removed instructions on changing IP address/Subnet Mask/ Activating DHCP and Printing 
templates from a USB storage device.

Chapter 3

WARNING: 
• Do not operate the printer without its cover and do not reach through its 

openings while it is running.
• Warning of hot surface: The curing process makes Marker Cards hot. Let Marker 

Cards cool off before removing them from the output rail.
• The openings in the enclosure of the printer must not be blocked or covered 

over.
• Do not insert any unintended objects through these openings.
• Make sure that no liquid gets into the printer.

IMPORTANT • Do not power off the printer. The printer automatically goes into standby 
mode. The operating parameters are only retained while the printer is 
turned on. These parameters confirm, for example, that the printhead is 
cleaned optimally.

• If the printer is turned off or is not used, this can lead to blockage of the ink 
nozzles after some time. 

• Print some Marker Cards every week. This is the only way to preserve print 
quality.

• Only remove ink cartridges when they are empty or have expired. 
• Removing an ink cartridge can cause leaks in the connection between the 

ink cartridge and the ink line. This can lead to a faulty ink feed system.
• Do not use ink that has expired.
• When the ink expiration date is approaching, a message is displayed on the 

touch panel. Replace the specified ink cartridge (see section Replacing ink 
cartridges).
Rockwell Automation Publication 1492-UM011D-EN-P- February 2020 5



Preface
Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation.

You can view or download publications at
http://www.rockwellautomation.com/global/literature-library/overview.page.

Resource Description

ClearTools™ Software User Manual, publication 1492-UM009 Provides information to install and use ClearTools 
Software.

Industrial Automation Wiring and Grounding Guidelines, 
publication 1770-4.1

Provides general guidelines for installing a Rockwell 
Automation industrial system.

Product Certifications website: rok.auto/certifications Provides declarations of conformity, certificates, and 
other certification details.
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Chapter 1

Product Overview

Introduction The ClearMark™ Advanced ink jet printer is a printing system for labeling 
Allen-Bradley Marker Cards. The data is created using ClearTools™ labeling 
software. This software is also used for installing the printer driver.

This system can be used for the individual marking of equipment quickly and 
conveniently. The ClearMark Advanced uses heat-curing ink-jet printing to print 
Marker Cards for switching devices, machines, terminal blocks, cables, wires, and 
valves. A secure and permanent label is achieved through high-level resistance to 
smearing and scratching, UV-stability, and the high printing resolution for all 
markers. The ClearMark Advanced allows you to print small fonts. Even the 
smallest characters are easy to read, permitting you to increase the information 
density on the marker.

• The Marker Cards can be fed individually or inserted as stack of up to 30. 
• The Marker Card that is fed into the printing unit is printed and then 

undergoes a heat curing cycle.
• Finally, the Marker Card is fed onto the output rail and can be removed.
• The Marker Card can be used immediately. 
• The Marker Cards become hot due to the heat curing process. If necessary, 

let them cool down before removing them from the output rail.
• The ClearMark Advanced should not be powered off. If the ClearMark 

Advanced is not used, it automatically goes into standby/energy-saving 
mode. This optimizes the cleaning cycles and thus increases the availability 
of the printer.
Rockwell Automation Publication 1492-UM011D-EN-P - February 2020 7



Chapter 1 Product Overview
Printer Figure 1 - Front view of the printer

Figure 2 - Rear view of the printer

Figure 3 - Open ink tank lid

Letter Item Letter Item

A Touch panel C Ink tank lid

B Service cover D Output rail

Letter Item Letter Item

A Filter cover D Stack input (loader)

B Connectors E Cleaning fluid

C Marker Card input

Letter Item

A Ink cartridges

B Ink Collector

C Ink tank lid (open)
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Product Overview Chapter 1
Connectors

Figure 4 - Connectors

Rating Nameplate

The rating plate contains information on the main voltage, article number, and 
serial number.

Figure 5 - Rating Nameplate

Letter Item

A Right-hand fuse (10 amperes)

B Main power supply connection

C Left-hand fuse (2.5 amperes)

D USB port for connecting Personal Computer

AB
C

D
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Chapter 1 Product Overview
Marker Cards Marker Cards made from plastic can be printed with the ClearMark Advanced 
printer.

The marking system, consisting of the ClearMark Advanced printer and the 
ClearTools software, has been designed by Rockwell Automation for Marker 
Cards. 

• The Marker Cards can be inserted individually or in stacks.
• Marker Cards can be broken in half. To do this, bend the card in the 

middle.
• Complete and half Marker Cards should not be mixed in a stack.
• It is, however, possible to process different marker card types in a stack: for 

example, catalog numbers 1492-M5X5, 1492-M5X12, and 1492-M6X10.

Figure 6 - Marker Cards 

Figure 7 - Description of the Marker Card

Letter Item

A Full Marker Card

B Half Marker Card

Letter Item

A First project marker surface

B Marker area

C Side strip
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Chapter 2

Setup

Unpacking

1. Open the packaging.

2. Take out the accessories.

3. Lift the printer with the polystyrene packaging material from the box.

4. Remove the polystyrene packaging material.

Included Items When you have taken the ClearMark™ Advanced and all accessories out of the 
packaging, make sure that you have the following items:

• Power cable
• USB cable
• One box of catalog number 1492-M5X5 Marker Cards
• Output rail
• DVD with the ClearTools™ software
• Quick Start guide
• Ruler for calibration

Installation Considerations Consider the following when installing the printer:
• Do not use the device near potential sources of electromagnetic 

interference, such as loudspeakers or the base stations of cordless 
telephones, as this can impair its function.

• Make sure that you provide the necessary operating and maintenance 
spaces.

• The printer must be placed on a flat, stable surface. The printer will not 
operate properly if it is tilted or at an angle.

IMPORTANT • Because of its weight, use two people to carry the printer. 
• Always hold the printer at the front and rear when carrying it. 
• Always transport the printer in a horizontal position. If transported 

improperly, ink can escape and soil or damage the device.

IMPORTANT Keep the original packaging for any future transport.
Rockwell Automation Publication 1492-UM011D-EN-P - February 2020 11



Chapter 2 Setup
• Avoid locations that are subject to strong fluctuations in temperature and 
humidity.

• Do not expose the printer to direct sunlight, strong light, or excessive heat.
• Avoid locations that are subject to impact shocks or vibrations.
• Do not use a table joined to other tables to avoid the transmission of 

vibration.
• Avoid installation sites that are subject to a large amount of dust.

1. Review the Installation Considerations. 

2. Place the printer on a surface that extends beyond the base area of the 
printer on all sides.

3. Leave enough space in front of the output rail to allow the printer to 
output Marker Cards without interference.

4. Install the printer in such a way that it is sufficiently ventilated on all sides.

5. Install the printer near a power socket so that the plug can be readily 
removed in the event of a fault.

Figure 8 - Operating and maintenance spaces

Letter Clearance Distance mm (in.)

A 250 (9.84)

B 200 (7.87) output rail

C 100 (3.94)

D 250 (9.84)

E 100 (3.94)
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Setup Chapter 2
Remove the Transport 
Restraints

Figure 9 - Transport restraints

1. Remove the transport restraints from the touch panel.

2. Remove the transport restraint from the ink tank lid.

Install the Output Rail Figure 10 - Installing the output rail

1. Install the output rail

2. Snap it into place.
Rockwell Automation Publication 1492-UM011D-EN-P - February 2020 13



Chapter 2 Setup
Position the Touch Panel The touch panel can be raised up to three rest positions. A click sound indicates 
that the touch panel is engaged in one of the rest positions. After a fourth click 
sound, the touch panel is unlocked and can be gently lowered down.

Figure 11 - Touch panel lowered

Figure 12 - Touch panel raised

Figure 13 - Rotating the touch panel

1. Raise the touch panel to the desired position.

The touch panel can be rotated 270°.

2. Rotate the touch panel by its handle (A) to the required position.
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Setup Chapter 2
Connect the Power Cable

Figure 14 - Connecting the power cable 

1. Connect the power cable to the printer (A).

2. Verify that the plug is inserted firmly.

WARNING: 
• The supply voltage must match the voltage that is given on the printer rating 

nameplate.
• Only connect the device to a properly grounded and fused socket.
• Do not use a socket already being used by devices that are turned on and off at 

regular intervals, such as photocopiers or fans.
• Do not connect the printer to either a switch-operated or a timer-controlled 

power outlet.
• If you connect the ClearMark Advanced printer to the power supply via an 

extension cable, confirm that the total nominal current of all devices connected 
to the extension cable does not exceed the ampere rating for that extension 
cable. 

• Make sure that the total nominal current of all devices that are connected to 
the wall socket does not exceed the ampere rating for that socket.

• When connecting the printer to the power supply, make sure that the building 
installation has an appropriate backup fuse. 

SHOCK HAZARD: 
• Warning of electrical hazard if the power cable is damaged. A damaged power 

cable can cause a fatal electric shock and lead to a fire.
• Do not place any objects on the power cable.
• Do not pull hard on the power cable and do not bend it any more than 

necessary.
• Failure to comply with these instructions can cause an electric shock or a fire.
• Insert the plug in a nearby socket and make sure that the socket is readily 

accessible.

A
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Chapter 2 Setup
Connecting the Printer The ClearMark Advanced is connected to a personal computer via USB cable.

Figure 15 - Connection 

Turn the Printer On/Off Figure 16 - Turning on the printer

1. Turn on the printer by briefly holding down the on/off switch (A).

IMPORTANT Do not connect the USB cable until you have installed the ClearTools application 
software.

IMPORTANT • Do not switch off the printer, the printer automatically goes into standby 
mode. 

• The operating parameters are only retained while the printer is turned on. 
These parameters confirm, for example, that the printhead is cleaned 
optimally.

• Turning off the printer or not using it can cause blockage of the ink nozzles 
after a while.

• Only turn the printer off to replace the service kit.
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Setup Chapter 2
Choose the Touch Panel 
Language

When you start up the printer for the first time, a language choice is displayed on 
the touch panel.

Figure 17 - Touch panel - language choice

1. Press the desired language and press Save.

If the printer was turned off before you chose the language or if you want to 
change the language later, perform the following steps:

Figure 18 - Touch panel - main menu

2. From the main menu, press SYSTEM INFO.
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Chapter 2 Setup
Figure 19 - Touch panel - System Info

3. Press LANGUAGE.

Figure 20 - Touch panel - language selection

4. Press the desired language and press SAVE.
18 Rockwell Automation Publication 1492-UM011D-EN-P - February 2020



Setup Chapter 2
Install ClearTools Software The marking system has been designed for the following operating systems: 
• Microsoft Windows® 7 (32-bit/64-bit versions)
• Windows 8
• Windows 8.1
• Windows 10

You can find information about the application software in the ClearTools user 
manual, publication 1492-UM009.

1. Insert the supplied DVD in the personal computer DVD drive.

The DVD starts automatically and the following screen appears

2. Click Software.

Figure 21 - ClearTools Installation - Start menu

3. Click ClearTools Software Installation.

Figure 22 - ClearTools Installation - software

IMPORTANT  Administrator rights are required for installation.
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Chapter 2 Setup
The installation process starts automatically and the setup wizard appears.

4. Click Next.

Figure 23 - ClearTools - setup wizard

5. Accept the terms in the license agreement and click Next.

Figure 24 - ClearTools - Accept the license terms

6. Choose the setup type.
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Setup Chapter 2
Figure 25 - ClearTools - Choose the setup type

7. Click Typical.

Figure 26 - ClearTools - starting the installation process

8. Click Install.

The installation process starts.

Installation Type Description

Typical The ClearTools program is installed with the most common features.

Custom The ClearTools program is installed; add-on modules can be selected/deselected. 

Complete The ClearTools program and all add-on modules are installed automatically.

Network The ClearTools program is installed on a shared drive on the network and can be used by 
multiple users. 
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Chapter 2 Setup
Figure 27 - ClearTools - status of the installation process

The installation status is shown by the progress bar.

Figure 28 - ClearTools - finishing the installation process

9. When the installation is completed, click Finish.
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Setup Chapter 2
USB Cable Connection

Figure 29 - Connection -USB cable

Figure 30 - ClearMark Advanced Explorer

1. To add the ClearMark Advanced, click Add.

Figure 31 - Choosing printer connection

2. Click USB.

The printer search starts.

IMPORTANT When you have installed the ClearTools application software, connect the USB 
cable to the printer. The printer driver is installed automatically.

Letter Description

A USB port

B USB cable

B A
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Chapter 2 Setup
Figure 32 - Printer search

The search result is displayed.

Figure 33 - Printer - search result

If no printer was found, you may start a new search process by clicking 
Search Again.

If a printer was found, click Add. The following dialog box appears:

Figure 34 - ClearMark Advanced Explorer

3. If you want to change the printer name, click Properties. 

This changed printer name is then displayed in ClearTools.

Figure 35 - Changing the printer name

4. Enter the printer name required for ClearTools, for example CMA 
Workplace 1 (USB1).

5. Confirm your inputs and click OK.
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The changed name CMA Workplace 1 (USB1) is displayed in the 
Explorer.

Figure 36 - Changed printer name

You can remove the highlighted printer from the list by clicking Delete.

You can add this printer again at any time.

To exit the dialog box, click close.

To check whether the printer that is highlighted in the list is connected 
and accessible, click Test.

If successful, the following dialog box appears:

Figure 37 - Dialog box - connection test successful

You see the following message if the printer cannot be found because, for 
example, it is turned off:

Figure 38 - Dialog box - printer not found

Running a Print Test When you have turned on the printer, run a print test.

Figure 39 - Touch panel - main menu

1. Press TEMPLATES on the touch panel main menu.
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2. Choose a template that corresponds to the supplied Marker Card.

Figure 40 - Touch panel - Templates

3. Insert the marker card. 

4. Press PRINT to run the print test.
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Operation

General Operation

WARNING: 
• Do not operate the printer without its cover and do not reach through its 

openings while it is running.
• Warning of hot surface: The curing process makes Marker Cards very hot. Let 

Marker Cards cool off before removing them from the output rail.
• The openings in the enclosure of the printer must not be blocked or covered 

over.
• Do not insert any unintended objects through these openings.
• Make sure that no liquid gets into the printer.

IMPORTANT • Do not power off the printer. The printer automatically goes into standby 
mode. The operating parameters are only retained while the printer is 
turned on. These parameters ensure, for example, that the printhead is 
cleaned optimally.

• If the printer is turned off or is not used, this can lead to blockage of the ink 
nozzles after some time. 

• Print some Marker Cards every week. This is the only way to preserve print 
quality.

• Only remove ink cartridges when they are empty or have expired. 
• Removing an ink cartridge can cause leaks in the connection between the 

ink cartridge and the ink line. This can lead to a faulty ink feed system.
• Do not use ink that has expired.
• When the ink expiration date is approaching, a message is displayed on the 

touch panel. Replace the specified ink cartridge (see section Replacing ink 
cartridges).
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Inserting Marker Cards

Marker Cards can be inserted directly without any prior handling. The end with the solid 
margin must be fed into the printer.

Figure 41 - Direction of insertion for Marker Cards

Processing a Single Marker Card

Place the single Marker Card on the conveyor belt (A) in the direction of the 
arrow.

Figure 42 - Inserting a single Marker Card

A
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Processing a Stack of Marker Cards

Figure 43 - Inserting a stack of Marker Cards

A—Loader to hold the stack

Software Setting Starting ClearTools

1. Start ClearTools™ via the program icon on the desktop or via Start menu.

Figure 44 - ClearTools program icon on the desktop

Mapping and Calibrating the Printer

A printer must be assigned for each Marker Card catalog number, for example: 
1492-M5X5.

Calibration must be carried out once for the printer, as this is a printer-specific 
zero point.

IMPORTANT • Only Marker Cards are allowed to be inserted in stacks.
• You can insert a stack of up to 30 Marker Cards in the loader.
• The stack must not exceed 30 Marker Cards.
• The stack must not contain a mix of full-size and half-size Marker Cards.
• Insert the stack of Marker Cards in the loader (A) in the direction of 

insertion shown previously. 

A
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Assigning a Printer

Figure 45 - Selecting a Marker Card

1. Choose for example, Marker Card>Terminal Markers.

2. Select the 1492-M5X5 Marker Card.

3. Click Select Product.

4. From the File menu, choose Print.

Figure 46 - Selecting the printer

5. Select the ClearMark™ Advanced printer that has been added.
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6. Click Map.

Figure 47 - Mapping the printer

7. In the dialog box that follows choose As Printer and click OK.

Figure 48 - Assigning variants to the printer

8. In this dialog box choose whether you want to assign all variants of the 
1492-M5X5 Marker Card to this printer.

If you click Yes, all versions of the Marker Card type 1492-M5X5 are assigned to 
the ClearMark Advanced and are always output on this printer unless this setting 
is changed.
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Printer Calibration

Figure 49 - Calibration

9. Click Calibration to determine the print position for the printer.

Figure 50 - Coordinate plane

10. Insert, for example, a 1492-M5X5 Marker Card in the printer (See 
Inserting Marker Cards on page 28 ).

11. Click Print Coordinate Plane.

12. Measure the X and Y values as shown below and enter them in the 
corresponding fields.
32 Rockwell Automation Publication 1492-UM011D-EN-P - February 2020



Operation Chapter 3
Figure 51 - Setting the printer correction

13. Enter the measured values in the Actual Width (X) and Actual height (Y) 
fields.

In the example above the measured values are 209.5 x 46. The printer must 
output the rectangle 0.22% larger in order to reach the required output 
size.

14. To check the dimensions, insert a 1492-M5X5 Marker Card in the printer 
again.

15. Click the Print Adjusted Rectangle.

16. When the dimensions are correct, confirm your inputs with the OK.

The printer has now been adjusted for all Marker Cards.

17. Next set the material-dependent slip.

Setting Material-dependent Slip

The material-dependent slip correction must take place for every Marker Card 
version, as it must be set material dependently.

1. From the menu bar choose Tools >Printer Settings >Set Material-
Dependent Slip...

2. Insert, for example, a 1492-M5X5 Marker Card in the printer (See 
Inserting Marker Cards on page 28 ).
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Figure 52 - Setting Material-dependent Slip

3. Print to a rectangle of the specified size (210 x 48 mm) by clicking the 
Print Rectangle.

4. Remove the printed Marker Card from the printer.

5. Measure the size of the printed rectangle.
34 Rockwell Automation Publication 1492-UM011D-EN-P - February 2020



Operation Chapter 3
Figure 53 - Material-dependent Slip - Entering the Measured Values

6. If the measured values differ from the specified size, enter these measured 
values in the Actual Width (X) and Actual height (Y) fields.

In the example above the measured values are 227 x 46. The printer must 
output the rectangle 0.44 % larger in order to reach the required output 
size.

7. To check the dimensions, insert a 1492-M5X5 Marker Card in the printer 
again.

8. Click Print Adjusted Rectangle.

9. When the dimensions are correct, confirm your inputs with OK.

10. Next adjust the Marker Card type.
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Adjusting Marker Cards

Marker Cards may not be their normal size, for example as a result of the ambient 
temperature. It is generally the width that is affected by such a change. You can 
adjust Marker Cards to compensate for these physical changes. The adjustment 
must be set for every Marker Card type.

1. From the menu bar choose File>Adjust Marker Type...

Figure 54 - Adjusting the marker type

2. Measure the width (X) from the beginning of the first project marker to 
the beginning of the last project marker (see figure above). 

3. To determine the height (Y), measure from the lower edge of the bottom 
marker to the upper edge of the top marker (see figure above).

4. Enter the actual measured values in the Width (X) and Height (Y) fields.

5. Enter the required values in the Offset (a) and Offset (b) fields to adjust 
the offset. 
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Figure 55 - Adjusting the Offset

6. Insert, for example, a 1492-M5X5 Marker Card in the printer (See 
Inserting Marker Cards on page 28 ).

7. Click the printer icon:

The printed Marker Card looks like this:

Figure 56 - Marker Card

Three squares and one row of dots were printed on the Marker Card.

Example of an incorrect zero point in the X direction (offset a)
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Figure 57 - Adjusting the Zero Point in the X Direction

In this example the three squares and the row of dots were printed 1 mm too far 
to the left.

To adjust this, it is necessary to change the value for Offset (a) in the Adjust 
Marker Type window (see Figure 54 on page 36). 

In this example the squares have to be shifted to the right. Consequently a 
positive value must be entered (1 mm in this example).

Example of an incorrect zero point in the Y direction (offset b)

Figure 58 - Adjusting the Zero Point in the Y Direction

In this example the three squares and the row of dots were printed 1 mm too far 
up.

To adjust this, it is necessary to change the value for Offset (b) in the Adjust 
Marker Type window (see Figure 54 on page 36).

In this example the squares have to be shifted down. Consequently a positive 
value must be entered (1 mm in this example).

Example of an incorrect width X (adjusting the centering for all markers)
38 Rockwell Automation Publication 1492-UM011D-EN-P - February 2020



Operation Chapter 3
Figure 59 - Adjusting the Centering in the X Direction

From marker to marker, printing is increasingly shifting from the center to the 
right. 

To adjust this, it is necessary to subtract the measured value (1 mm in this 
example) from the actual value for Width (X) in the Adjust Marker Type 
window (see Figure 54 on page 36). 

If printing is increasingly shifting, from marker to marker, from the center to the 
left, it is necessary to add the measured value to the current value for 'Width (X)' 
in the 'Adjust Marker Type' window (see Figure 54 on page 36).

Example of an incorrect height Y (adjusting the centering for all markers)

Figure 60 - Adjusting the centering in the Y direction

From marker to marker, printing is increasingly shifting from the center upward. 

To adjust this, it is necessary to subtract the measured value (1 mm in this 
example) from the current value for Height (Y) in the Adjust Marker Type 
window (see Figure 54 on page 36).

If printing is increasingly shifting, from marker to marker, from the center 
downward, it is necessary to add the measured value to the current value for 
Height (Y) in the Adjust Marker Type window (see Figure 54 on page 36).
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Printing Marker Cards

1. Start the ClearTools software.

2. Select the required Marker Card.

3. Enter the text or insert an image or barcode that you want to print.

4. Insert the Marker Card or the Marker Card stack.

5. Start printing via ClearTools. 

Curing Settings / Heating level

The settings for curing Marker Cards differ and are applied automatically. 

It is possible to set a higher or lower intensity for curing. Details on fine 
adjustment of the heating level can be found in the ClearTools user manual.

After cooling, check each Marker Card for resistance to smudging and 
scratching.

Selecting the Print Quality

It is possible to determine the print quality. Details on this process can be found 
in the ClearTools user manual.

Touch Panel The touch panel enables you to look up information about the printer such as the 
current ink level in the cartridges, view and delete print jobs and carry out 
maintenance. You can also set the required language for the touch panel and print 
out sample templates. 

The touch panel displays prompts to change the ink cartridges and to maintain 
the printer.

The touch panel can be raised and rotated to the position you require 
(See Position the Touch Panel on page 14).
40 Rockwell Automation Publication 1492-UM011D-EN-P - February 2020



Operation Chapter 3
Menu Structure of the Touch Panel
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Main Menu

Figure 61 - Touch Panel - Main Menu

The printer status is shown in the bottom line. In the example above the printer is 
Ready. 

From the main menu, choose the appropriate sub menu: TEMPLATES, PRINT 
JOBS, TOOLS and SYSTEM INFO.

The bottom part of the main menu shows the ink level of the individual 
cartridges. You can find exact details of the ink level under SYSTEM INFO in 
the second window (See System Info on page 43). 

Submenus

Others are available in the submenus:

Displays the next page.

Displays the previous page.

Takes you back to the main menu.

 The currently selected menu, for example System Info, is shown at 
the top of the touch panel.
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System Info

1. Press SYSTEM INFO on the touch panel's main menu.

Figure 62 - Touch Panel - System Info 1

Figure 63 - Touch Panel - System Info 2

The following sections provide more information about the individual menu 
items.

Changing the Printer Name

The preset printer name is always the serial number. You can assign a self-
explanatory name to the printer to be able to identify it better. Follow these steps:

1. In the first System Info window, press PRINTER NAME. 

2. Enter the desired printer name via the on-screen keys and press SAVE.

To delete entire entry, press X.

To enter a space character, press Space
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Figure 64 - Touch Panel - System Info 1 - Printer Name 

To switch to numeric keys, press123.

Figure 65 - Touch Panel - System Info 1 - Printer Name 

3. In this window you can enter the required data via the numeric keys.

You can delete the entire entry with the [X] key.

4. Save your inputs by pressing SAVE.

5. It may be necessary to restart the printer (if so, a message is then displayed 
on the touch panel).
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Changing the USB Port

Whenever a printer is installed via a USB port, USB - 001 is assigned to it. If you 
connect a second printer to the PC, USB - 001 is automatically assigned to this 
printer, too. A different USB port must therefore be assigned manually to the 
second printer, e.g. USB - 002 or USB - 003. Proceed as follows to make this 
change: 

1. In the first System Info window, touch the [USB PORT].

Figure 66 - Touch Panel - System Info - USB port

2. Select the desired USB port and press SAVE.

Ink Level

Press INK LEVEL to display information about the ink cartridge. 

1. In the second System Info window, press INK LEVEL.

Figure 67 - Touch panel - System Info - Ink Level

2. If you enter the respective color, a window opens with further information 
about the selected ink cartridge.
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Figure 68 - Touch Panel - System Info - Information of Ink

Protocol

Press PROTOCOL to display an overview of printer events. 

1. In the second System Info window, press PROTOCOL.

Figure 69 - Touch Panel - System Info - Protocol

The window shows the error messages of the last 4 weeks. 
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Information

1. In the second System Info window, press INFORMATION.

Figure 70 - Touch Panel - System Info - Information

Information about the ClearMark Advanced is displayed here, e.g. which 
firmware version is currently in use or how many Marker Cards have been 
printed.

Tools

Press TOOLS on the main menu to carry out the following maintenance tasks.

Figure 71 - Touch Panel - Tools

You will find a description of the individual maintenance tasks in Chapter 4.
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Print Jobs

1. Press PRINT JOBS on the main menu, to display the print jobs in the 
queue.

Here you can also delete print jobs if, for example, the wrong file was sent 
to the printer.

Figure 72 - Touch Panel - Print Jobs

This window shows all pending print jobs.

1. Select the print job that you want to delete by touching it.

2. Press EDIT to stop the printer.

3. Press DELETE.

A print job that has already started cannot be deleted. The power cable 
must not be disconnected during printing.

Templates

1. Press TEMPLATES on the touch panel's main menu.

Figure 73 - Touch Panel Templates

Under TEMPLATES you will find sample templates, for example for 
printing tests.

2. Select the template that you want to print.

3. Insert the corresponding Marker Card in the printer.

4. Press PRINT to execute the print job.



Chapter 4

Cleaning and Maintenance

Tools Menu Figure 74 - Touch Panel - Main Menu

1. Press TOOLS in the main menu.

The following screen is then displayed:

Figure 75 - Touch Panel - Tools
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Printhead Cleaning

Figure 76 - Printhead cleaning

Carry out printhead cleaning if the print quality deteriorates.

1. Press TOOLS in the main menu.

2. Press HEAD CLEANING in the Tools menu.

Figure 77 - Touch Panel - Printhead Cleaning 

3. Press NO if printhead cleaning should not be executed

4. Press YES if printhead cleaning should be executed:

Printhead cleaning takes approx. 2 minutes. The following message is 
displayed on the touch panel during printhead cleaning:

Figure 78 - Touch Panel - Printhead Cleaning Duration

5. Print out a Marker Card. If the printing result is still not satisfactory, 
execute printhead flushing.
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Printhead Flushing

If you have carried out printhead cleaning and the printing result is still not 
satisfactory, execute printhead flushing. With printhead flushing, considerably 
more ink is used than with printhead cleaning.

1. Press TOOLS in the main menu.

2. Press HEAD FLUSHING in the Tools menu.

Figure 79 - Touch Panel - Printhead Flushing

3. Press NO if printhead flushing should not be executed:

4. Press YES if printhead flushing should be executed:

Printhead flushing takes approx. 5 minutes. The following message is 
displayed at the touch panel:

Figure 80 - Touch Panel - Printhead Flushing Duration

Executing a Sensor Check

In a sensor check, all sensors in the printer are checked to make sure they are 
functioning. If a sensor is soiled, for example, it cannot detect when a Marker 
Card passes through.

1. Insert a Marker Card in the printer.

2. Press TOOLS in the main menu.

3. Press SENSOR CHECK in the Tools menu.
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Figure 81 - Touch Panel - Execute Sensor Check

4. Press NO if a sensor check should not be executed:

5. Press YES if a sensor check should be executed:

All sensors in the system are now checked. The following window is 
displayed during this time:

Figure 82 - Touch Panel - Sensor Check in Progress

A status page is subsequently displayed which presents the sensors and 
shows whether they are correct or not.

Contact a service technician in case of an error.

Replacing Ink Cartridges Replace the ink cartridges when they are empty or their expiration date has been 
reached.

Handling Ink Cartridges

Observe the following information when replacing ink cartridges:
• The ink cartridges are sealed units. Under normal circumstances, ink will 

not leak out of an ink cartridge. Do not try to disassemble or try to refill 
ink cartridges.

• Always handle used ink cartridges with care as ink can be in the ink supply 
outlet. Do not shake ink cartridges, as this may cause ink to leak.

• If you get ink on your hands, wash them thoroughly with soap and water. If 
you get ink in your eyes, rinse immediately with plenty of water.
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• If you accidentally swallow any ink, rinse out your mouth and drink plenty 
of water. Do not induce vomiting.

• When the use-by date of the ink approaches (printed on the packaging), a 
message is displayed at the touch panel. Replace the specified ink cartridge. 
Use all the ink in the ink cartridge by the date stated on the label to achieve 
the best print results.

• Using expired ink reduces the print quality and can cause damage to the 
printer. Damages due to the use of out-of-date ink cartridges are excluded 
from the warranty.

• Store unopened ink cartridges in a cool and dry place, preferably in a 
refrigerator at about 4 °C.

• Before using an ink cartridge that has been stored in a colder place, allow 
the cartridge to stand at room temperature for at least three hours.

• Install ink cartridges in the printer immediately after removing them from 
the packaging. The print quality can be impaired if an ink cartridge is left 
unpacked for any length of time before use.

• Ink is used when a new ink cartridge is inserted or when the ink tank lid is 
opened, as the printer always carries out a reliability check.

The ink filling level can be displayed at the touch panel; if necessary, replace the 
ink cartridges. 

1. Press SYSTEM INFO in the main menu.

2. Change to the second page of the System info

3. Press INK LEVEL.

Figure 83 - Touch Panel - System Info - Ink Level

If the expiration date of an ink cartridge has been reached, a message is 
automatically displayed on the touch panel.
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Figure 84 - Touch Panel - Ink Cartridge Out-of-Date

Important components can become blocked and the printer may be damaged if 
you press YES and continue to print with the out-of-date ink cartridge. Damages 
due to the use of out-of-date ink cartridges are excluded from the warranty. 
Therefore, replace out-of-date ink cartridges immediately! (Also see information 
shown via PLEASE NOTE)

4. Press NO

5. Replace the ink cartridge.

The following information is displayed after pressing INFORMATION:

Figure 85 - Touch Panel - Note: Ink Expired

IMPORTANT If you open the ink tank lid, the printer will stop. 
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Figure 86 - Opening the Ink Tank Lid

1. Open the ink tank lid by pressing the finger recess (A).

Figure 87 - Removing the Ink Cartridge

2. Remove the ink cartridge which must be replaced by extracting it 
horizontally.
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Information on Inserting Ink Cartridges

The ink cartridges are electronically and mechanically coded, ensuring they can 
only be inserted correctly.

Figure 88 - Coding of the ink cartridges

Figure 89 - Positions of the ink cartridges 

 Letter Description

A Electronic coding

B Mechanical coding

Letter Description

A Black ink cartridge (K)

B Cyan ink cartridge (C)

C Magenta ink cartridge (M)

D Yellow ink cartridge (Y)
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3. Remove the ink cartridge from its packaging.

Figure 90 - Inserting an ink cartridge

4. Insert the ink cartridge into the printer. The ink cartridge is properly 
inserted when it snaps into place.

Replacing the Ink Collector Replace the ink collector if a touch panel message displays that it is full.

Proceed as follows for more information:

1. Press OK.

Figure 91 - Error message - ink collector 

IMPORTANT • Do not open the ink collector. The complete tray must be replaced. 
• Dispose of the ink collector through an authorized dealer or at a suitable 

hazardous materials disposal center. Check local regulations before 
attempting to dispose of the ink collector yourself.

• If you open the ink tank lid, the printer stops. 
Rockwell Automation Publication 1492-UM011D-EN-P - February 2020 57



Chapter 4 Cleaning and Maintenance
Figure 92 - Opening the ink tank lid 

1. Open the ink tank lid by pressing the finger recess (A).

Figure 93 - Unlock the ink collector 

2. Press the interlock (B) downwards

Figure 94 - Extracting the ink collector 

3. Remove the ink collector (C). 

4. Insert the new ink collector horizontally.
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Cleaning the Printer 
Enclosure

Cleaning the Touch Panel Clean the touch panel with a cleaning agent suitable for touch screens and a soft, 
lint-free cloth.

Updating the Printer 
Software

Proceed as follows to update the printer software:

1. Start the ClearTools™ program.

2. In ClearTools, choose Tools, then Options.

3. In the Options window, choose the entry ClearMark™ Advanced and then 
Administration.

Figure 95 - ClearTools - updating the printer software

SHOCK HAZARD: When cleaning the printer, ensure that no moisture enters it.
• Only clean the printer enclosure. Only service technicians should clean the 

inside of the printer.
• Keep moisture away from live parts as it can cause short-circuits.

IMPORTANT Regularly clean the outside of the printer enclosure using a soft, dry or slightly 
moistened wipe.
Do not use volatile chemicals such as benzene, thinning fluid or insecticide on 
the printer. The use of such chemicals can result in damage to the printer 
including cracks or color changes.
If the dirt does not come off, initially wipe the printer with a wipe moistened 
with a neutral cleaning agent, then with a moist cloth, and finally with a dry 
cloth.
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4. Select the update file, in the example above it is the 'update.zip' file.

5. Click on the [Start printer update] and the following message is displayed.

Figure 96 - ClearTools - updating the printer software

6. Confirm the message, click YES.

A successful software update is displayed on the touch panel of the printer.

7. Press OK to confirm it at the touch panel of the printer.

Replacing the Service Kit If the print quality is no longer satisfactory, try cleaning the print head. If the 
quality does not improve, replace the service kit. See Accessories on page 76. 

1. Disconnect the printer from power source.

2. Open the service cover.

Figure 97 - Unlocking the service cover

3. Insert a flat-blade screwdriver in the lock (A) and unlock the service cover 
(B).
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Figure 98 - Detaching the service cover

4. Open the service cover (A) and detach it.

Figure 99 - Disconnecting the connectors

5. Disconnect the connectors (A) and (B).

Before you can remove the service kit, put the printhead in the unlocking 
position.
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Figure 100 - Service Kit Unlocked 

Figure 101 - Unlocking the Service Kit 

6. Insert a screwdriver in the printhead release (A) and turn the printhead (B) 
90° counterclockwise so that it reaches the unlocking position 

7. Remove the service kit's retaining screw (C).

IMPORTANT Turn the printhead just 90° counterclockwise. Turning it clockwise will ruin the 
mechanism.
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Figure 102 - Removing the Injector 

8. Slightly raise the injector (A) to remove it from the catch.

Figure 103 - Removing the retaining screws

9. Remove the service kit's retaining screws (A) and (B).

IMPORTANT Put on the disposable gloves.
Hold the service kit as level as possible when removing. 
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Figure 104 - Removing the service kit

10. Pull out the service kit (A) carefully.

Figure 105 - Cleaning printhead A

11. Clean printhead A with one of the wipes provided.

IMPORTANT The service set contains two wipes to clean the two printheads. 
To clean the printheads properly, use a separate/new wipe service kit for each 
printhead. 
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Figure 106 - Cleaning printhead B

12. Clean printhead B with the second wipe provided.

Figure 107 - Pushing in the service kit

13. Push in the new service kit (A).
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Figure 108 - Fastening the service kit

14. Fasten the service kit with the screws (A) and (B).

Figure 109 - Fastening the injector 

15. Reattach the injector (B) carefully and fasten it with the screw (A).
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Figure 110 - Reconnecting the connectors

16. Reconnect the connectors (A) and (B).

Figure 111 - Closing the service cover

17. Reattach the service cover (A) and close it.
Rockwell Automation Publication 1492-UM011D-EN-P - February 2020 67



Chapter 4 Cleaning and Maintenance
Figure 112 - Locking the service cover

18. Insert a flat-blade screwdriver in the lock (A) and lock the service cover 
(B).

19. Reconnect the printer to power (see Connect the Power Cable on 
page 15) Turn the printer back on (see Turn the Printer On/Off on 
page 16).
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Replacing Cleaning Fluid 
Bottle

Replace cleaning fluid bottle if it is empty. See Accessories on page 76

Figure 113 - Removing the hood 

1. Detach the hood (A) over the cleaning fluid bottle (B).

Figure 114 - Unscrewing the bottle out of the top

2. Unscrew the empty bottle (A) out of the top.
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Figure 115 - Screwing the bottle into the top

3. Screw a full cleaning fluid bottle (A) into the top.

Figure 116 - Reattaching the hood

4. Reattach the hood (B) over the cleaning fluid bottle (A). 
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Troubleshooting 

General Information A message on the touch panel indicates a printer fault or when an ink cartridge 
needs to be replaced.

Touch the [SYSTEMINFO] in the main menu of the touch panel for more 
detailed information about this message and to see which measures should be 
taken. Change to the second page of the System Info and touch the 
[PROTOCOL]. The event is displayed. Use the [DETAILS] to display further 
information and an appropriate proposed solution. 

EXAMPLE The printing results are unsatisfactory. The printed image is too weak or is 
spotted. Check the printer status.

Printer Status Possible Solution

Has the printer not been used for a 
long time?

The ink might have dried up or the printhead nozzles are blocked. If necessary, 
clean the printhead. See Printhead Flushing on page 51

Is the printed image unclear or 
doubled?

In this case, contact Rockwell Automation Technical Support. 

Is there a problem with the printer's 
location?

Make sure that the printer is located on a flat even surface. Install the printer 
at a site that is free from vibration.

A Marker Card is stuck in the printer Power off the printer and then power it back on again.The card stuck in the 
printer will be fed out.

The print is irregular, either too strong 
or too weak

Check the following if there is a problem with the print quality, such as 
irregular print or inappropriate ink quantity:
Are you using an out-of-date ink cartridge?
Using expired ink reduces the print quality and can cause damage to the 
printer.

The printouts are dirty or spotted
Check the following if the printed 
marker areas are dirty or spotted:

Have you touched the unprinted marker areas of the Marker Card?
Do not touch the unprinted marker area

Are the Marker Cards aligned correctly?
Check the alignment of the inserted Marker Card.

Are you using an original Rockwell Automation® ink cartridge?
Only use original Rockwell Automation ink cartridges.
The printer may be damaged if you are not using an original Rockwell 
Automation ink cartridge or if you are using a refilled cartridge. 

Opening the ink tank lid during the 
print process

Printing is canceled if the ink tank lid is opened during the printing process.
If you open the lid before the heating unit has switched on, the printing 
process will resume as soon as the lid is closed.
If you open the lid while the heating unit is already activated, the heating unit 
will be switched off. The current Marker Card will be printed and fed out of the 
printer without fixation. 
A message is displayed on the touch panel.
The filling level of the ink cartridges is set to 'empty'. The printer 
automatically starts re-initialization of the ink tank system (takes up to 2 
minutes).
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List of Events
Code Event Measure Information

30019 Left internal ink collector unit is 
nearly full.

Please contact your Rockwell Automation 
representative to ensure the operating 
status.

Unlike the ink collecting tray that can be replaced 
easily by the user, the internal ink collector unit is 
firmly fitted and can therefore only be replaced by 
a service technician.

If the internal ink collector unit is full, the printer 
stops the operation in order to prevent print 
system malfunctions.
Only qualified service technicians should replace 
components inside the device.

30021 Right internal ink collector unit is 
nearly full.

Please contact your Rockwell Automation 
representative to ensure the operating 
status.

Unlike the ink collecting tray that can be replaced 
easily by the user, the internal ink collector unit is 
firmly fitted and can therefore only be replaced by 
a service technician.

If the internal ink collector unit is full, the printer 
stops the operation in order to prevent print 
system malfunctions.
Only qualified service technicians should replace 
components inside the device.

10032 Ink collecting tray is nearly full. Make sure that a new ink collecting tray 
is available. 
Catalog number 1492-PCMACOLLECT.

To avoid waiting due to a full ink collecting tray, 
you should make sure that you always have a new 
ink collecting tray available.

10072 The BLACK ink cartridge (K) is 
nearly empty.

The ink cartridge is nearly used up.
Make sure that a new ink cartridge is 
available.
Catalog number 1492-PCMAINK-K.

If the ink cartridge is empty, the printer stops the 
operation in order to prevent print system 
malfunctions.

10073 The CYAN ink cartridge (C) is nearly 
empty.

The ink cartridge is nearly used up.
Make sure that a new ink cartridge is 
available.
Catalog number 1492-PCMAINK-C.

If the ink cartridge is empty, the printer stops the 
operation in order to prevent print system 
malfunctions.

10074 The MAGENTA ink cartridge (M) is 
nearly empty.

The ink cartridge is nearly used up.
Make sure that a new ink cartridge is 
available.
Catalog number 1492-PCMAINK-M.

If the ink cartridge is empty, the printer stops the 
operation in order to prevent print system 
malfunctions.

10075 The YELLOW ink cartridge (Y) is 
nearly empty.

The ink cartridge is nearly used up. 
Make sure that a new ink cartridge is 
available.
Catalog number 1492-PCMAINK-Y.

If the ink cartridge is empty, the printer stops the 
operation in order to prevent print system 
malfunctions.

30626 The cleaning procedure failed. Replace the ink cartridge if necessary.
Restart the printer.

There may be too little or no color in one of the ink 
cartridges.
If the message is displayed again, please contact 
your Rockwell Automation representative.

40012 The expiry date for BLACK (K) has 
passed.

Replace the BLACK ink cartridge (K).
Catalog number 1492-PCMAINK-K.

Rockwell Automation urgently recommends that 
you do not continue to print with inks that have 
expired, as this can damage the printer. To 
continue printing, click on [Notes] and confirm 
that you wish to continue on the next screen.

Each ink cartridge has an expiry date.
This helps to protect the print system and to 
maintain consistent labeling quality.
Once the expiry date has passed, the properties of 
the ink deteriorate. Important components can be 
clogged and cause permanent damage to the 
printer.
To minimize the risk of damage to the device, the 
device automatically performs additional cleaning 
procedures once the expiry date has passed.
This can also increase the consumption of inks that 
have not expired. Rockwell Automation 
recommends that you always replace expired ink 
cartridges immediately.
Rockwell Automation shall not accept any 
responsibility for the quality or reliability of 
expired ink cartridges.
Servicing or repairs to the device that are 
necessary as a result of expired ink cartridges are 
excluded from the warranty.

40013 The expiry date for CYAN (C) has 
passed.

Replace the CYAN ink cartridge (C).
Catalog number 1492-PCMAINK-C.

Rockwell Automation urgently recommends that 
you do not continue to print with inks that have 
expired, as this can damage the printer. To 
continue printing, click on [Notes] and confirm 
that you wish to continue on the next screen.

40014 The expiry for MAGENTA (M) has 
passed.

Replace the MAGENTA ink cartridge (M).
Catalog number 1492-PCMAINK-M.

Rockwell Automation urgently recommends that 
you do not continue to print with inks that have 
expired, as this can damage the printer. To 
continue printing, click on [Notes] and confirm 
that you wish to continue on the next screen.

40015 The expiry date for YELLOW (Y) has 
passed.

Replace the YELLOW ink cartridge (Y).
Catalog number 1492-PCMAINK-Y.

Rockwell Automation urgently recommends that 
you do not continue to print with inks that have 
expired, as this can damage the printer. To 
continue printing, click on [Notes] and confirm 
that you wish to continue on the next screen.
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40002 Faulty BLACK ink cartridge (K). Restart the printer.
Replace the BLACK ink cartridge (K).
Catalog number 1492-PCMAINK-K.

Only use original ClearMark™ Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

Printer faults and damage caused by the use of 
unapproved and unsuitable accessories and 
consumables are excluded from the warranty.
Furthermore, Rockwell Automation shall not 
accept any responsibility for the print quality and 
print resistance if third-party software, markers or 
inks have been used that have not been approved 
by Rockwell Automation for this system.

40003 Faulty CYAN ink cartridge (C). Restart the printer.
Replace the CYAN ink cartridge (C).
Catalog number 1492-PCMAINK-C.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40004 Faulty MAGENTA ink cartridge (M). Restart the printer.
Replace the MAGENTA ink cartridge (M).
Catalog number 1492-PCMAINK-M.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40005 Faulty YELLOW ink cartridge (Y). Restart the printer.
Replace the YELLOW ink cartridge (Y).
Catalog number 1492-PCMAINK-Y.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40205 The ink tank cover is open. Close the ink tank cover. Please contact your Rockwell Automation 
representative if the error persists.

40101 No ink cartridges have been 
detected.

Insert the ink cartridges and make sure 
that they are fully engaged.

Please contact your Rockwell Automation 
representative if the error persists.

40172 Faulty BLACK ink cartridge (K). Restart the printer.
Replace the BLACK ink cartridge (K).
Catalog number 1492-PCMAINK-K.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

Printer faults and damage caused by the use of 
unapproved and unsuitable accessories and 
consumables are excluded from the warranty.
Furthermore, Rockwell Automation shall not 
accept any responsibility for the print quality and 
print resistance if third-party software, markers or 
inks have been used that have not been approved 
by Rockwell Automation for this system.

40173 Faulty CYAN ink cartridge (C). Restart the printer.
Replace the CYAN ink cartridge (C).
Catalog number 1492-PCMAINK-C.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40174 Faulty MAGENTA ink cartridge (M). Restart the printer.
Replace the MAGENTA ink cartridge (M).
Catalog number 1492-PCMAINK-M.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40175 Faulty YELLOW ink cartridge (Y). Restart the printer.
Replace the YELLOW ink cartridge (Y).
Catalog number 1492-PCMAINK-Y.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

40030 Faulty ink collecting tray. Restart the printer.
Replace the ink collecting tray. 
Catalog number 1492-PCMACOLLECT.

Only use original ClearMark Advanced ink 
cartridges.
Please contact your Rockwell Automation 
representative if the error persists.

Do not open the ink collector. The complete tray 
must be replaced.
Dispose of the ink collector through an authorized 
dealer or at a suitable hazardous materials 
disposal center.
Check local regulations before attempting to 
dispose of the ink collector yourself.

40159 The ink collecting tray was not 
inserted correctly.

Insert the ink collecting tray correctly 
and make sure that it is fully engaged.
Restart the printer if necessary.

If the message is displayed again, please contact 
your Rockwell Automation representative.

40904 The temperature is too high. Wait a while until the printer has 
acclimatized.
Restart the printer.

If the message is displayed again, please contact 
your Rockwell Automation representative.

40905 The temperature is too low. Wait a while until the printer has 
acclimatized.
Restart the printer.

If the message is displayed again, please contact 
your Rockwell Automation representative.

40011 The ink collector unit is full. Replace the ink collector unit. 
Catalog number 1492-PCMACOLLECT.

If the ink collector unit is full, you can no longer 
continue to print.

Do not open the 
ink collector. The complete tray must be replaced.
Dispose of the ink collector through an authorized 
dealer or at a suitable hazardous materials 
disposal center.
Check local regulations before attempting to 
dispose of the ink collector yourself.

10044 The temperature is too low. Wait a while until the printer has 
acclimatized.
Restart the printer.

If the message is displayed again, please contact 
your Rockwell Automation representative.

10045 The temperature is too high. Wait a while until the printer has 
acclimatized.
Restart the printer.

If the message is displayed again, please contact 
your Rockwell Automation representative.

Code Event Measure Information
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Internal error Restart the printer. If the message is displayed again, please contact 
your Rockwell Automation representative.

60005 Transport timeout Restart the printer.
Carry out a sensor test.

The marker was not transported within the 
defined time. 
If the message is displayed again, please contact 
your Rockwell Automation representative.

60006 Internal error Restart the printer. If the message is displayed again, please contact 
your Rockwell Automation representative.

60007 Faulty ink cartridge. Restart the printer.
Check that the ink cartridge is installed 
correctly.
Please contact your Rockwell Automation 
representative if the error persists.

Only use original ClearMark Advanced ink 
cartridges.

Printer faults and damage caused by the use of 
unapproved and unsuitable accessories and 
consumables are excluded from the warranty.
Furthermore, Rockwell Automation shall not 
accept any responsibility for the print quality and 
print resistance if third-party software, markers or 
inks have been used that have not been approved 
by Rockwell Automation for this system. 

60008 Transport timeout Restart the printer.
Carry out a sensor test.

The marker was not transported within the 
defined time. 
If the message is displayed again, please contact 
your Rockwell Automation representative.

60009 Internal error Restart the printer. If the message is displayed again, please contact 
your Rockwell Automation representative.

Code Event Measure Information
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Technical Specifications
Technical data

Application Printing on Rockwell Automation Marker Cards 

Technology Ink-jet process with heat curing

Print quality 600 dpi, 1200 dpi

Labeling and marking software ClearTools™

System requirements Microsoft® Windows 7, Windows 8, Windows 8.1, Windows 10

Feed Automatic loader for max. 30 Marker Cards (for Marker Cards only)
Single feed for Marker Cards

Interface USB 1.1/2.0

Voltage supply AC 100-120 V / 8 A, 50/60 Hz

Fuses Right-hand fuse: 10 AHT 240/120V
Left-hand fuse: 2.5 AHT 240/120 V

Operating location Office conditions

Ambient temperature 10 …35 °C (50 …95 °F)

Dimensions (L x W x H) Length including output rail: 
Length without output rail: 
Width: 
Height with folded down touch panel:
Height with folded up touch panel:

approx. 1138 mm (44.80 in.)
approx. 945 mm (37.20 in.)
554 mm (21.81 in.)
328 mm (12.91 in.)
422 mm (16.61in.)

Weight 57.8 kg (127.43 lb) with packaging
37.2 kg (82.01 lb) without packaging

Ink system Color system → 1 x black 1 x cyan, 1 x magenta, 1 x yellow

Scope of supply • ClearMark™ Advanced
• Power cable
• USB cable
• 1 box of catalog number 1492-M5X5 Marker Cards
• Output rail
• DVD with the ClearTools software
• Quick start guide
• Ruler for calibration
• The printer is equipped with ink cartridges and the ink collector.
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Accessories
Description Catalog Number Part Number

ClearMark Advanced 1492-PCMA110 PN-505632

Black ink cartridge 1492-PCMAINK-K PN-505636

Cyan ink cartridge 1492-PCMAINK-C PN-505634

Magenta ink cartridge 1492-PCMAINK-M PN-505637

Yellow ink cartridge 1492-PCMAINK-Y PN-505638

Ink collecting tray 1492-PCMACOLLECT PN-505640

100 ml bottle with fluid 1492-PCMAFLUID PN-505641

Cleaner tissue 1492-PCMACLEANER PN-505642

Service kit 1492-PCMASERVKIT PN-505643
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Rockwell Automation Support

Use the following resources to access support information.

Documentation Feedback

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this 
document, complete the How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/
documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, 
User Forums, and Product Notification Updates.

https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone 
Numbers

Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-
now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the 
code to route your call directly to a technical support 
engineer.

http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data.

http://www.rockwellautomation.com/global/literature-library/
overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated 
firmware.

http://www.rockwellautomation.com/global/support/pcdc.page 

.

EEE Yönetmeliðine Uygundur. (In Conformity with the EEE Regulation)

Battery Notice: This product contains Perchlorate material. Special handling may apply. For more information, go to http://www.dtsc.ca.gov/
hazardouswaste/perchlorate/

• At the end of its life, this equipment should be collected separately from any unsorted municipal waste.
• This product contains a sealed lithium battery which is permanently connected and should only be removed or replaced by 

trained professionals. 
• At the end of its life, the battery contained in this product should be collected separately from any unsorted municipal waste. 

The collection and recycling of batteries helps protect the environment and contributes to the conservation of natural resources 
as valuable materials are recovered.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Rockwell Automation maintains current product environmental information on its website at http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

Allen-Bradley, ClearMark, ClearTools, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.

Microsoft and Windows are trademarks of Microsoft Corporation

Trademarks not belonging to Rockwell Automation are property of their respective companies.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/
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